
 

Campaign KPIs should reflect your business goals and how they can be
achieved online. Use a metric value to determine what success looks like, this is
your KPI (key performance indicator). Benchmark your campaign against
predefined KPIs to measure the success of your search campaign including
conversion traffic, awareness and brand impressions.

 

#1 Conversion Traffic

Qualified traffic – The function of Google Ads is to drive qualified traffic from
users looking for your product. This can result in conversions if your site is
optimized to their expectations and your offering matches their need state.
Ultimately, it’s traffic with a possibility of other desirable actions like purchases,
conversions and brand awareness.

 

#2 Awareness

If you need to drive awareness, building lists of relevant generic keywords will
expand the reach of your offering beyond the people who already know and
search for your brand. Generic keywords tend to have higher CPCs and lower
conversion rates so it’s important to measure the success of your generic
campaigns in terms of reach and acceptable cost per conversion.
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#3 Brand Searches

Brand searches are low-cost and high conversion. However, for the majority of
businesses, impressions and clicks tend to be lower than generic searches so
driving a higher number of brand searches should be a goal of all organizations.
This can also act as a de facto measure of your brand growth.

 

 

Conversion tracking shows you what happens after a customer clicks on your
ad. It is a means to measure valuable actions like sales or leads generated on
your site following a click.
Most websites will have different conversions with different outcomes and
values to the business. Here are some examples of different conversion types
(conversion category type can be set up when creating conversion tracking),
e.g.

Leads
Purchases
Phone calls
Downloads 

Depending on the value of the conversion to your business, you can determine
what campaigns can be focused and managed to drive certain conversion
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types. This will allow for better budget allocation and managing cost per
conversion type.

Adding conversion traffic allows you to track back to the campaign and
keywords the number of valuable actions taken by users from a campaign. This
will have an associated cost and provide other metrics which will allow you to
determine if it’s profitable or scalable.

It’s possible to track actions taken on a website like lead form completions
or e-commerce transactions
You can create campaigns that link to the App or Play Store and you can
count the number of App installs resulting from your campaigns
When people search on mobile and call your business directly from the
SERP, it is possible to measure the number of phone calls and the length
of each phone call resulting from an ad click
You can also import goals from Google Analytics, firebase or third-party
app analytics software

Conversions can be created on the manager account level and shared among
child accounts (e.g. Where multiple product lines for one brand is controlled by
a manager account with each product line having its own account) or at the
individual account level (to keep conversion data separate).

 

To access conversions, click the wrench icon in the top right of the AdWords
screen and under Measurement, click ‘Conversions’. The next screen will display
the image shown on this slide.

 

 

There are two ways to add conversion tracking to Google Ads:

1.The first is to add a piece of tracking code to the thank you/confirmation page
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following a conversion. This is the page that shows after you contact the team
or complete a purchase. It usually says thank you for your purchase etc. This
page is only ever displayed after conversion, so every time it’s displayed, your
tag on that page tells AdWords that a conversion has happened.
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2. The other way is to use click tracking and insert a piece of code into a button
on your website, i.e. when someone clicks a button to start a video or submit a
lead form but there is no thank you page because the button was clicked, the
conversion is tracked.

 

 

Now to talk about other metrics! There are a number of metrics
available to see if your campaign is successful or not. These include:

Impressions: the number of times an ad is served to audiences
Clicks: how often an ad is clicked
Cost-Per-Click (CPC): the actual price paid for each click in a PPC campaign
Click-Through-Rate (CTR): the % number of impressions that lead to a click
Cost-Per-Impression (CPM): the cost for serving a batch of 1,000
impressions
Cost-Per-Acquisition (CPA): how much it costs in PPC advertising media
spend to generate a sale/conversion
Avg. Position: where an ad is shown on a search result page
Conversions: an action an advertiser has defined as valuable on a website,
e.g. purchase, contact form completion
Conversion Rate the % number of clicks that turned into conversions
Cost per conversion: the total cost of generating traffic divided by the total
number of conversions
Impression share: the number of impressions received divided by the
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estimated number of impressions that were available
Click/Impression assisted conversions: the number of conversions that
were assisted by a particular campaign, ad group, or keyword.
Quality Score: An estimate of how relevant your ads, keywords, and
landing page are to a person seeing your ad

 

These metrics aren’t always in real-time but they can be provided to advertisers
in almost real-time within a 24-hour period.

 

 

You can see performance metrics like impressions, clicks, conversions, and.
position cost per conversion and impression share at the keyword, ad group,
and campaign level. You can schedule your reports to run daily, weekly etc. and
have them emailed to specified recipients.

 

Steps:

Click into one of your campaigns or ad groups
Press the columns icon and click Modify columns on the right-hand side,
below the graph and choose what metrics you want to include in your
report
Save this set of columns if you will be using it often

Filters give you an immediate change to the metrics you’re viewing on-screen
to make some optimization decisions.

You can run reports on the different tabs in AdWords, e.g. Campaign report, Ad
Group report, Keyword report etc. to measure the success of your search
campaigns.



The steps to run these reports are:

 

Select the level of report you want from the left-hand menu, e.g.,
Campaigns
Click the three dots icon for ‘More Options
Download the report into .csv or .xlsx
Open your data in Excel and report on critical metrics.

You can segment the data by clicking the circle icon. Segment by
Conversions, Click Type, Device, Network, Top vs. Other and Time
(day/week/month/quarter, etc.) for additional insights.
If you want to add additional data to your report, you can also segment the
data by clicking More Options > Download > Click to add segments.
Filters are also a way to segment your view, but when you download a
report, you can add a segment to give extra granularity to your reporting.

When you download a segmented report, this can then be used in a Pivot table
to give greater insights over time, e.g. Month, Day, Week, Device, Day of the
Week etc.
Steps:

To create a Pivot table of your data, select all of the data in the Excel
report, navigate to the Insert menu in Excel, and choose Pivot Table
Press OK in the pop-up window to insert Pivot Table
Drag and drop the data point into the “Row Labels” box, e.g. Campaign
Drag and drop the metric into the “Values” box to add up all your data for
the row items, e.g. clicks, impressions, cost,
Don’t drag formula metrics like CPC, CTR, CPM or Cost per
Conversion into the values tab as it adds up the data and you’ll
end up with incorrect data.
You can further segment your data by adding Columns by dragging a data
point into the “Column Labels” box, e.g. Day of the week
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In the example above we are looking at all clicks (values) for a campaign (rows)
which is split by Day of the week (date range for the report = 2 months), you
can set your date range for the entire year to see what are the most important
days for your metrics, just be aware if there is any seasonality in your yearly
activity as this can skew the data.
This is a very good way of aggregating many rows of data into an easily
understandable table, and we can see which days drive the most clicks. We
could also look at conversions and increase spend on high-conversion days or
reduce spending on low-conversion days. This is an example of using data
insights to create better performance. It’s really important to test these
changes first to estimate impact.

 

 

To measure the success of your paid search campaigns, link your
Google Ads account with Google Analytics. This will help you to:

Enhance your reporting with detailed website engagement
See how paid search channels perform against other channels
Measure ROAS for e-commerce clients
Get a deeper understanding of what searchers do post-click

 

Follow the steps below to link Google Ads with Google Analytics:

Sign in to both AdWords and Analytics
Navigate to the Admin tab in Google Analytics
Choose “AdWords linking” from the Property level options list and select
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the accounts or manager account to link

 

You can also access Google Analytics in Google Google Ads once they
are linked:

Use the shortcut to Google Analytics in the Tools tab in AdWords to quickly
access your website’s Analytics data (once linked)
This tab allows for fast access to the linked Google Analytics account so
you can begin to analyze campaign performance in terms of website
engagements, conversions, events, and e-commerce activity
You can also access the planning tools, look at attribution modeling (a set
of rules that determine how the credit for conversions should be attributed
to various keywords, ad groups, and campaigns), conversion data, and
preview your ads in a test environment

 

To see your AdWords cost click and impression data, navigate to the
Acquisition tab in Google Analytics and choose the AdWords menu
In this menu, you can see the linked accounts in your manager account,
campaigns, sitelinks, keywords, search queries and segmented by an hour
of the day. You can further segment your data by adding a secondary
dimension to the report to see how each keyword does against other data
points like device type, date, month, etc.
This view gives you detailed website engagement, goal conversion, e-
commerce, and click data all in one AdWords view.

 

NOTE: This is a reporting view only, you can’t make any changes to AdWords
campaigns from Google Analytics, it’s for viewing AdWords metrics only. 

For deeper reporting in Google Analytics, consider website engagement



metrics to determine the quality of AdWords clicks not just in terms of
conversion rate or scale
Engagement metrics include: the number of pages visited, average time on
site, bounce rate (the % of people who leave the site after only viewing one
page), and new or returning visitors
You can also compare metrics. In the screenshot shown, traffic is steady
each day but some days drive more goal completions
Analysis and recording of these types of trends can help uncover why, so
you can take the correct steps to improve performance

 

You can also link Analytics to AdWords and easily import a small number of
metrics like pages visited, bounce rate, and time on site
By viewing this engagement data in AdWords you can quickly make
decisions about your campaigns without having to switch to Google
Analytics
You can link Google Analytics to AdWords by clicking on the main menu
(three dots at the top of the AdWords screen) and choosing linked
accounts, then navigate to the Google Analytics option (as above) and link
AdWords to Google Analytics
You can also important Google Analytics goals and e-commerce data in
AdWords to align your goal tracking between interfaces in the
conversions area within the main menu (three dots at the top of the
screen)
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Paid and Organic search work side by side so by linking Search Console to
AdWords, you can enhance your paid vs. organic reports and see whether
users are choosing your paid clicks ahead of organic listings
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You can then determine if there are gaps in either search experience
You can link search console to AdWords in the same place as you linked
Google Analytics to AdWords, i.e. in the main menu (three dots at the top
of the screen) and then in the Linked Accounts area (as above).

 

NOTE: You need to be logged into Search Console too in order to complete the
link

Every time you make a significant change in AdWords or perform an
optimization (bids, new ads, keywords, campaigns, pausing items, etc.),
you can add a small note in Google Analytics below the graph which can
help identify action taken which has impacted performance
You can then revert this change in the AdWords change history if it has had
a drastic impact on performance

 

Change history is used for troubleshooting: to look back on changes made
by you or others in your account, set your date, and view change history.
This is particularly useful for identifying positive or negative changes in
performance.
You can undo some of the actions in the change history to reverse changes
that were made if it had a negative impact on performance.
If there is a change in performance and you have added an annotation in
Google Analytics to mark the change you made on a certain day, use this
as a starter to know what you should look for in the change history.

Steps:

Access Change history for a campaign by clicking into the campaign then
clicking on “Change History” on the left-hand menu
Set the date range you want to look at
If you want to undo a change click “Undo” below the item to revert it to its



previous state
Action Point
PS:I know you might agree with some of the points that I have raised in
this article. You might not agree with some of the issues raised. Let me
know your views about the topic discussed. We will appreciate it if you
could drop your comment. Thanks in anticipation.
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